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§§ 1.1 IP  System Description

2-Wire systems do NOT need more cable wires to connect the components together. All 
the signal transfer for the system is sent via the two power wires in the power cable.

IP technology is the most common and advanced network, and the direction of system 
integration.

Now, 2-wire system and IP network are integrated. The IP network makes standalone 2-wire 
systems working together, so it can be used for complex residential blocks, even for large 
system.

As IP network is the backbone bus, it is ideal for simplifying installation. The system can 
also share the existing Ethernet(LAN) network, without a dedicated network cabling and 
cost.

Thanks to IP-Agent switchboard software, IP-2 wire system makes the door intercom can 
be available in a PC as well as from the Indoor Monitor, for answering calls and releasing 
doors. Additionally, video surveillance and recording can be achieved using extra CCTV 
cameras in network as well as entrance door station cameras.
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§§ 1.2  IP  System Part List

PC software

Handset with desk mount to connect with PC.

IP Guard Station with 10" TFT touch screen

The switchboard software may be installed on 
desktop or laptop pc.

Works with IP-Agent, to answer calls just by 
pick up the handset, and with 2 Unlock Buttons 
in panel.

* Windows 7 OS is recommended
* SQL server database is required exceptionally, 
if multi PC stations are installed

* One USB2.0 port is required
* Microphone and Speaker socket will be 
connected

* PS5-24V power supply is required

Switchboard: IP-Agent software

HS-PC Handset kit for IP-Agent

Switchboard: IP-G21 Guard Unit

Switchboard Functions:

IP‐Agent Software:

IP‐G21 Guard Station:

•	 Answering calls from Door Station, Common Door Station, Intercom Point
•	 Answering calls from User Monitor
•	 Call Door Station, Common Door Station, Intercom Point
•	 Call User Monitor
•	 Call and communication with another online PC station or Guard station
•	 Entrance and Network cameras surveillance
•	 Door release function if called by Door Station or Common Door Station
•	 Call event list (Out, In, Missed calls)
•	 Transfer to another PC station or Guard station, if multi switchboards are installed

•	 Video manual/auto recording and image capture, playback in multi windows

•	 Image capture and playback (800 images can be saved in flash memory)
•	 If 4~32GB SD card can be installed (More than 40000 images can be recorded)
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IP Gateway Converter for 2-wire system

IP Gateway Converter for CCTV camera

Digital keypad Door Panel

Direct-select Door Panel

1/2 Call Button Small Door Station

* Set DIP switches correctly according to DS/
CDS usage

* Note: Set ID Code to 0~3 for DS mode
* Note: Set ID Code to 4 to CDS mode

* Note: Can be used as Common Door Station 
directly

* Work in Villa block, or Intercom Point in 
system

IP Gateway Converter: DT-IPC

IP Gateway Converter: CM-IPC

DMR18

DMR11 and EP11 Series

DT-59X

* Note: For other components in system, please refer to 2-wire product information
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DT-IPCDT-IPC

2

2
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DBC-4

DBC-4

PS5-24VDPS

DPS PS5

PS5-24VDPS

DPS PS5

DBC-4 distributor

DBC-4

DBC-4 distributor

DBC-4

MENUTALK MONITORMENUTALK MONITOR

MENUTALK MONITORMENUTALK MONITOR

MENUTALK MONITORMENUTALK MONITOR

MENUTALK MONITORMENUTALK MONITOR

Ethernet Switcher

SOS

2

3

44 8

7 65 1

IP network: 2-wire system:

1) Max. 6 PC Station (IP-Agent switchboard)
2) Max. 8 IP-G21 Guard Station
3) Max. 200 2-wire system blocks
4) Max. 200 Intercom Point
5) Max. 32 Common Door Station
6) Max. 32 IP network camera controller
7) Max. >10Km distance (By using optical fiber)
*Note: For 3/4/5/6 items, total number < 240

1) Max. 32 Monitors in each block
2) Max. 4 Door Stations in each block
3) Max. 300m distance
4) Max. 6 CCTV cameras

* Note: Refer to DT technical Guide

System Capacity

§§ 1.3 IP  System Features
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Entrance Door Station

User Monitor

Video Distributor

IP interface unit (DT-IPC)

Common Door Station

Switchboard using IP-G21

Switchboard using PC

Network Switcher
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§§ 1.4 IP  System Typical Applications

1.4.1 Connect with PC in single family system

1.4.2 Connect Common Door Station in system

DT-IPC
CM-IPC

PS5-24VDPS

DPS PS5

MENUTALK MONITOR MENUTALK MONITOR

PS4

VT-QSW

Video Surveilance

IP Home Network

PC

1. Answer calls and release the door from PC
2. Monitoring Door Station camera or Video Surveillance cameras from PC

1. All Common Door Stations can call all the unit in each apartment
2. Switchboard is not needed in this case

IP Home Network

Apartment 1

MENUTALK MONITOR MENUTALK MONITOR

Apartment N

Common Door Station

1 2 3

654

7 8 9

#0*

RF CARD

DT-IPC

PS5-24VDPS

DPS PS5

MENUTALK MONITOR MENUTALK MONITOR

DT-IPC

PS5-24VDPS

DPS PS5 DT-IPC

PS5-24VDPS

DPS PS5
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1.4.3 IP system Diagram for complex residential buildings
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§§ 1.5 Wiring Diagram

1.5.1 Connect with PC in single family system
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1.5.2 Connect Common Door Station in Apartment compound
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1.5.3 Connect Intercom point in network

DT-IPC

IP  Network

Intercom Point

DPSPS5

Switchboard

Block

DT-IPC

Ethernet Switcher

To next DT-IPC 
of blocks

Switchboard

DPS PS4

MENUTALK MONITOR MENUTALK MONITOR

DT-IPC

PS5-24VDPS

DPS PS5
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1.5.4 Connect Quad switched 4 Cameras in one CM‐IPC node

IP  Network

Switchboard

DT-IPC

Ethernet Switcher

To next DT-IPC 
of blocks

Switchboard

PS4

CM-IPCPS4

VT-QSW

Video Surveilance

QSW

POWERIN-USE

Block

MENUTALK MONITOR MENUTALK MONITOR

DT-IPC

PS5-24VDPS

DPS PS5
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1.5.5 Connect Multi Door Stations in block system

•• DBC4S is used for Door Station distributor (Setup the current according to different models)
•• Refer DT system technical Guide for reference

DT-IPC

IP  Network

DPSPS5

MENUTALK MONITOR MENUTALK MONITOR

Switchboard

Block

DT-IPC

Ethernet Switcher

To monitors

To next DT-IPC 
of blocks

Switchboard

DBC4S

A  B  C  DINOUT

DBC4S

A  B  C  DINOUT

85~260AC

DPS PS5
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1.5.6 A complex installation example with Common Door Station and Switchboard
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1.5.7 Optical Fiber connection for very long distance

•• LAN network using fiber optic, brings insulation among the systems; this ensures a higher degree of 
immunity from lightning damages.

•• Using IP as repeater can meet a large distance between the Door Station and Monitor.

DT-IPCDPSPS5 DT-IPC

DPSPS5

MENUTALK MONITOR MENUTALK MONITOR

Block

To monitors

85~260AC

DPS PS5DT-IPC

85~260AC

DPS PS5DT-IPC

Fiber Converter

Fiber Converter

Fiber Cable

-15-
IP-2 wire system technical guide



Chapter 2

Product Introduction

2.1. IP-G21 Description

2.1.1 About IP-G21 Unit

2.1.2 Parts and Functions

2.1.3 About main menu

2.1.4 Specification

2.2. DT-IPC Introduction

2.2.1 About DT-IPC Unit

2.2.2 Parts and Functions

2.2.3 Specifiction

2.2.4 Installation Setup Instructions

2.2.5 Wiring Diagram

2.2.6 IP Address Setup
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The IP-G21 Guard Unit is designed as a dedicated switchboard to support IP network 
system, which can be used for 2-wire or CAT5 network system. 

Guard Unit is an essential part in IP system, it makes possible to manage calls from(to) 
Common Door Station or Door Station, and Indoor Monitor.  

Additionally, IP-G21 has other functions, such as alarm receiver, depends on system 
configuration. 

Max. 8 IP-G21 can be connected in system.

•	 10 inch digital TFT with its resolution of 800x480 pixels
•	 Touch screen operation
•	 Handset or hands free answering
•	 Make intercom call to common door station,door station,and indoor monitor

2.1.2 Parts and Functions

Handset

Speaker

Microphone

Unlock button

Intercom button

LED indicator

LCD screen

2.1.3 About main menu

The main menu is your starting point for using all the applications on G21.

To open the main menu page, press the LCD screen anywhere twice.Please see the above 
diagram.total 7 items shown on main menu page:Manaul Monitor,Intercom,Event,User 
Setup,Shortup,Service,Close.

§§ 2.1 IP-G21  Description

2.1.1 About IP-G21 Unit
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a.Manual Monitor:

Press Manual Monitor icon on main menu page,a digital keypad will be shown on screen.
Input the address by pressing the keypad,then press unlock or monitor icon,you can 
release the door or see the conditions of common door staion or door staion.

Otherwise,you can monitor or release the door for common door station or door station by 
namelist,please press List icon to show the name list.
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b.Intercom:

c.Event:

The Guard Station can make a call to common door station,door station and indoor 
monitor,just input the address by pressing keypad,then press Dial icon to activate the 
intercom call.(the intercom call also can be activated by namelist,just press List icon to 
show name list )

Press Event icon on main menu page ,total 8 items on this page.

It's available for G21 to search alarm and calling information, and can directly clear all 
events on G21.just press Event Clear icon.
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The G21 supports picture memory function,and the pictures can be playbacked on G21,at 
this page ,press Memory Playback icon ,each memo can display 4 pictures named by 
date, and the pictures can be copied to SD card,just press Memory to SD icon.

2012-01-10              004

2012-01-10              002

2012-01-10              003

2012-01-10              001

d.User Setup:

User setup includes date and time set,ring tone set,monitor time set,password set,call 
divert set,menu upgrate,and system tools set.These setting items can be modified at any 
time.If you want to restore the settings to their default value.Please press Restore to 
default icon.
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e.Shortup:

f.Service:

This section offers more convenient and effective methods for guard person to make a 
call,just pressing the icon,calling is activated immediately.

Power input:                                 DC 24Vdc (supplied by DT-DPS)
Standby Current:                          190 mA
Working Current:                          250mA
Screen:                                         10 inch digital TFT
Resolution:                                    800x480pixels
Video Signal:                                CCIR, 1Vp-p , 75Ω
Transmission Mode:                     TCP/IP
Connection Port:                           RJ45
Network Interface:                        Standard Ethernet interface
Working temperature:                   +5ºC ~ +40ºC
Dimension:                                   382(W)X203(H)X32(D)mm

2.1.4 Specification
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The DT-TPC unit is designed for DT 2-wire system to support IP networking. It is a network 
gateway which is an essential node in IP network. 

DT-IPC is capable of connecting block system and Common Door Station, intercom 
point. It makes the door intercom can 
be available in a PC as well as from the 
Indoor station or Guard Unit. Answering 
calls and releasing doors, or monitoring 
entrances are also available. 

Max. 239 DT-IPC can be connected in 
system. 
•	 One DT-IPC is required in one block.
•	 Built-in watchdog circuit in case of 

crash.
•	 LED Indicators to show system status
•	 RJ45 Standard connection port
•	 IP address setting & store
•	 Talking volume  adjustable
•	 Support TCP/IP network and fiber transmission or broad band network access.
•	 Adopt MPEG4  video protocol and G.729 audio protocol.
•	 Include 100Mbit Ethernet LAN and RS485 connection port.

150mm 140 mm

60
 m

m

2.2.1 About DT-IPC Unit

2.2.2 Parts and Functions

1

ON DIP

2 3 4 5 6

DIPON

1 2 3 4

J701
IPC-CT

IPC-PORT

K201
LED202

SW201
CN-BSO CN-BSI CN-DS

RS485 S201

LED203

Diagram:

§§ 2.2  DT-IPC Introduction
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Terminal description:

Item Name Description

Status indicator LED202
After power on for 10s,it will flicker
Always on while working

LED203

DIP switches
SW201 Refer to DIP switches setting in followings 

S201 Refer to DIP switches setting in followings

Network Signal Input J701  RJ45 connection,  connected to network.

Bus Signal Output CN-BSO 2 wire terminal connection,to DT-DPS connection

Bus signal input CN-BS1
2 wire terminal connection, to monitors or DBC4s 
that monitors are connected 

Bus signal input CN-DS
Connected to door station or DBC4s that door 
stations are connected

Prog Button K201 Reserved

PC port RS485
Set parameters of DT-IPC by PC that is connected 
by RS485-USB Convertor

Power input:                                 DC 24Vdc (supplied by DT-DPS)
Standby Current:                          190 mA
Working Current:                          250mA
Video Signal:                                CCIR, 1Vp-p , 75Ω
Audio Signal:                                300~3,400 KHz, 0~240 mV 
Transmission Mode:                     TCP/IP
Connection Port:                           RJ45
Network Interface:                        Standard Ethernet interface
Working temperature:                   +5ºC ~ +40ºC
Dimension:                                   140(W)X60(H)X150(D)mm

2.2.3 Specification
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2.2.4 Installation Setup Instructions

DIP Switch Status(Defaults are OFF)

a) DIP switches settings:

ON(1)

=

OFF(0)

=
ONON

S201 switches settings:

Total 6 bits switches.Bit-6 is used to set the video impedance matches. 

Functions of bit1 to bit 5 are reserved. 

1 2 3 4 5 6

ON

1 2 3 4 5 6

ON

SW201 switches settings:

Bit state Setting Bit state Setting

Set to high 
impedance

Match video 
impedance

Item Bit state  Descriptions

Bit-1 / / Reserved

Bit-2
Villa application mode

Apartment application mode

Bit-3

Set to "on",press Direct Call Guard Unit on monitor to 
call switchboard 

Set to "off",press Direct Call Guard Unit on monitor to 
call local Guard monitor

Bit-4
Set as common door station

Set as door station

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON

1 2 3 4

ON
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2.2.5 Wiring Diagram

station

Guard Unit

DT-IPC

1 2 3 4 5 6

ON

CODE=1,DIP6=OFF

1 2 3 4 5 6

ON

CODE=2,DIP6=OFF

1 2 3 4 5 6

ON

CODE=3,DIP6=OFF

1 2 3 4 5 6

ON

CODE=4,DIP6=OFF

SOS

A Block B Block C Block D Block

-25-
IP-2 wire system technical guide



station

Guard Unit

DT-IPC

1 2 3 4 5 6

ON

CODE=1,DIP6=OFF

1 2 3 4 5 6

ON

CODE=2,DIP6=OFF

1 2 3 4 5 6

ON

CODE=3,DIP6=OFF

1 2 3 4 5 6

ON

CODE=4,DIP6=OFF

SOS

A Block B Block C Block D Block
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2.2.6 IP Address Setup

1. General Rules for IP Adress Setup

2. IP Address Setup by IP8210 Config Software

For constructing a DEDICATED LAN for IP system, all network devices must be specified 
different IP Address. 

*  Network device model includes DT-IPC, CM-IPC, IP-G21 and PC Station.We will just 
state device short for network device in the following statement.

*  All network device can be detected by IP8210 config and IP-Device, but only DT-IPC, 
CM-IPC & IP-G21 can be set by the two softwares. PC Station is set by Windows IP setup

All the devices must be in the same IP Segment.(Assume that using the segment:   
192.168.0.X  in this manual )

*  192.168.0.1 is used as a network gateway. Devices can’t be set to this address

*  All devices must be set a unique IP address & MAC address 

*  If more than one device have the same IP address, only one of them can be available

   by IP8210 config or IP-Device software

*  If PC & the device to be set have the same IP, the device can’t be detected by IP8210 
config or IP-Device software  in this PC.

*  Here are the table for range of device IP address

Range: Device:

192.168.0. 2 – 192.168.0. 240 DT-IPC, CM-IPC

192.168.0.241– 192.168.0.246 PC Station(IP-Agent)

192.168.0.247 – 192.168.0.254 Guard Station(IP-G21)

For new devices, IP address of devices are initialized to the same address, so it’s 
recommended that IP address of devices is set one by one. It’s easily fulfilled via IP8210 
Config software. 
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Steps for IP Setup

a.Set PC IP address (Assume that IP of PC is set to 192.168.0. 125)

*  See the notification area in the bottom right corner of windows desktop

*  Press  icon in the notification area. It will 
pop up a window for selecting network.

Click Open Network and Sharing Center item.

*  Select Local Network in the pop-up window.
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*  Press Properties button in the 
Local Network Status window

*  Select Internet Protocol Version 
4(TCP/IPv4) item in the Networking 
tab of Local Network Properties 
window

*  Select Use the following IP 
address option in the General tab 
of Inter Protocol Version 4(TCP/
IPv4) Properties window
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*   Input IP address, Subnet mask 
and Default gateway as following 
picture shows, then press OK 
button to finish setup

b. Connect device to PC directly or the network

c. Start IP-8210 Config Software

* The path to get the software:  \K 2012\Tool\IP8210Config\
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d. Press Search… button to search the device. You can press Stop button to end the 
search after the device has been detected. Just like the following picture shows

e. Select the device in the Device List frame, then press Config button
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f. It will pop up a window for IP address config. Modify IP address, and then press OK 
button to confirm. Its Mac address will be automatically modified simultaneously.

g.  If setup is successful, it will pop up a window to inform you. Press ‘Confirm’ button  
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3. IP Adress Setup by IP Device Software

An IP setup tool has been inserted in IP Device software. The function is the same to 
IP8210 config software.

Steps for IP Setup

a)  Install PC Station package software. And IP Device software shortcut will be created 
automatically in the desktop.

b)  Set PC Station IP

Assume using the following IP address :

IP address: 192.168.0.246  

Subnet mask: 255.255.255.0

Default gateway: 192.168.0.1

Note that IP address range of PC station must be from 192.168.X.241 to 192.168.X.246. X 
is the specific segment number that is configurated by IP Device. Assume that 0 segment 
has been specified.

c)  Connect the device to PC directly or the network

The following is a diagram of network connection

DT-IPC DT-IPC DT-IPC

SOS

2

2 wire riser

2

2 wire riser

2

2 wire riser

2 wire IP 
interface
(DT-IPC)

2 wire IP 
interface
(DT-IPC)

2 wire IP 
interface
(DT-IPC)

IP backbone

IP backbone installed 
using a dedicated LAN 
network

Guard Unit PC
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d)  Start IP Device software

e)  Click right mouse button on Benchmark Project, then select IP Node Config in the 
pop-up menu

f)  In IP Node Config page, press Scan & Check button
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g)  Then it will pop up a window to show devices that are detected.  Assume that 
192.168.0.2 is the device that is supposed to be set to 192.168.0.93.
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h)  Double click 192.168.0.2, then a window pops up for modifying IP, input 93 then Mac 
address will be automatically modified. Press OK button to confirm modification. 

i)  A window will be pop up to inform you if config succeed, just like the following picture shows. Press 
‘confirm’ button
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4. Find Specific Network Device in IP System

In the IP system, if you want to check device IP or find specific network device, you can 
operate it as follows, take DT-IPC as example. 

1)  Press K201 button in DT-IPC

2)  Device info will be shown in IP device software in 2s. The device info format is as 
following picture: ‘Device Test Tip:’ + Device name + Device IP

a. Check Device IP
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b. Find Specific Network Device

If you don’t know the related device of specific IP address, you can find out the relationship 
by tip device function in IP device software.

1)  Select one IP device you want to check, click right mouse button on it, select Tip 
Device in the pop-up menu.

2)  Then LED202(red)&LED203(blue) of the related DT-IPC will blink 8 times 
simultaneously. 
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5. Check Network Device Online

The status of devices is unchecked after configurated. The following are two methods for 
checking network device online

1)  Press Refresh Online button on the left-bottom corner in main page of IP device 
software. 

2)  Click right mouse button on Benchmark Project, then select Check Network Device 
Online in the pop-up menu. 

As you see, D Block, Guard Station 2 & Guard Station 1 are offline.  Network Camera is 
online, but device model doesn’t correspond with the connected device. Other devices is 
normally online.
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Chapter 3

Software Introduction

3.1. Software Installation

3.2. IP-Device Introduction

3.3. IP-Agent Introduction

3.3. 1 Overview

3.3. 2 IP-Agent Description

3.3. 3 Monitor Viewer

3.3. 4 Record Viewer

3.3. 5 Capture Viewer

3.3. 6 Setting
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§§ 3.1 Software Installation

1. Double Click Setup.exe. Start to install PC Station

2. Select language, then click Next.

3. Click Next

4. Select folder for installation, then click next

5. Click Install button to begin the installation, then waiting till installation finishes.
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1. Double Click Setup.exe. Start to install PC Station

2. Select language, then click Next.

3. Click Next

4. Select folder for installation, then click next

5. Click Install button to begin the installation, then waiting till installation finishes.
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6. Then click Finish button to confirm it

7 Please note the default login info:

ID: Device
Password: 123456
Server Name: Machine Name + ‘\K2012’
Database Name: K2012
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6. Then click Finish button to confirm it

7 Please note the default login info:

ID: Device
Password: 123456
Server Name: Machine Name + ‘\K2012’
Database Name: K2012
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§§ 3.2. IP-Device Introduction

IP-Device is used to construct a new project and save project info to a database for IP-
Agent whose info is based on the database.  

Recommended Configuration Route:

Project Property -> IP Node Config -> Block Config -> Guard Centre Priority Setting -> Call 
Table for Blocks -> Call Table for Common Entrance -> Parameter Management for Blocks 
and Common Entrance

IP Device Interface Instructions

1.  Project Property

Start the IP Device Software

Click the right mouse button on Default Project, then it will pop up a menu. Select Project Property
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It will pop up a window for setting project property.

IP Seg: Select a IP Segment for the new project. We will take 192.168.0.X as an example 
in this manual*

Project Name: Name the new project

Project Description: Can input some info about project

Project Mark: Can input some info about project

Insert time line: Insert created time in Project Mark frame.

See the picture above, Benchmark 
Project is assumed a 2 wire/IP 
system.

Click Save button to save info when 
finish

*Note that IP Seg just can be set at 
the first time. It’s to say, IP segment 
isn’t editable after first set.
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2.IP Node Config

Click the right mouse button on Benchmark Project, then select IP Node Config. Select IP 
nodes which will be adopted in this project, select its model and name the device.

IP Nodes Description

192.168.0.2 to 192.168.0.240 Door Station/Common Door Station/
Camera

192.168.0.241 to 192.168.0.246 PC Station( IP-Agent )
192.168.0.247 to 192.168.0.254 Guard Unit

Model Name Model Description

C5-IPC_CDS C5-IPC for Common Door Station
C5-IPC_DS C5-IPC for Door Station
CM-IPC IPC for CCTV Camera
DT-IPC_CDS DT-IPC for Common Door Station
DT-IPC_DS DT-IPC for Door Station
GL-IPC Guard Unit
PC PC Station( IP-Agent )
ST-IPC IP8210

IP Nodes Description

Model Description
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For example, in Benchmark Project, see the table, IP Nodes can be configured like the 
following picture

IP Device

192.168.0.20 Camera
192.168.0.20 to 192.168.0.24 Door Station
192.168.0.25 to 192.168.0.26 Common Door Station
192.168.0.254 and 192.168.0.253 Guard Unit( IP-G21 )
192.168.0.243 and 192.168.0.244 PC Station( IP-Agent )

IP Node Config:

If all the device has been installed in the project, you can click the Scan & Check button to 
search if the selected IP Nodes are online. If not installed yet, click Save button to write the 
info to the database. Then main interface will show the devices like the following picture.
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If you want to check if the devices are online, you can press Refresh Online button or click 
right mouse button on Benchmark Project then select Check Network Device Online. See 
the following picture,   Means device offline, and   means PC is online, but IP-Agent isn’t 
opened.   indicates the model of IP Node is wrong selected, or wrong DIP switch setting of 
IPC.
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3.  Block Config

Double Click A Block, you will find no door stations and monitors there. Door stations and 
monitors must be configured.

Take Benchmark Project as an example. There are 2 DT592 and 4 monitors in A blocks. 
User Codes of monitors are 00, 01, 02 and 03 respectively.

DS Config: Click the right mouse button on A Block -> Select DS Config on the pop-up 
window -> Config just like the following picture -> Click Save button to confirm -> Software 
will check if the door stations are online automatically.  
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Monitor Config: Click the right mouse button on A Block -> Select Monitor Config on the 
pop-up window -> Config just like the following picture -> Click Save button to confirm -> 
Software will check if the monitors are online automatically.  
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Note that 0032(User code) is equal to 0000 when door station is DT592 or DT596 
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DS and Monitors Config of other blocks in Benchmark Project can use the same method to 
config.

4. Guard Centre Priority Setting

This setting is configured for guard centre( PC Station and Guard Unit) priority.
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See the following picture, there are 8 position for calling transfer. For example, when one 
door station or monitor call Guard Centre, it will call GL 1 firstly, if GL 1 is busy or offline, 
the calling will be diverted to GL2, if GL2 is busy or offline, the calling will be diverted to GL 
3… Repeat this till divert the calling to the last Guard Centre.

Press the Write to all device button to download the info to all devices connected to the 
network, and info will be saved to database at the same time. If only press Save button, the 
info just is kept in the database, isn’t downloaded to devices.
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5.  Call Table For Blocks

For DT-IPC of blocks, there is 2 call tables for calling guard station: Button Call Table and 
Call Priority. 

The route for Call Table(Take B Block as an example): Click right mouse button on B Block 
-> Management -> Call Table, see the following picture, both of them have 2 buttons, View 
& Edit and View On Device. Press View & Edit, you can view the table in the database 
and edit, then can download the edited table to the corresponding DT-IPC. Press View On 
Device, you can check the call table in the corresponding DT-IPC.

Button Call Table: This table is for door station and monitors calling guard centre

The table is actually a Mapping between Guard Centre and Door station/Monitor. 

It’s to say:

For door station, press the specified button(DMR11) or input the specified No.(DMR18) to 
call the corresponding Guard Centre.

For Monitors, press the specified No. in the Namelist to call the corresponding Guard 
Centre.

1)  View & Edit

Click Add Guard Centre button to pick one Guard Centre for 32 
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Pick one Guard Centre for 32, then press ok button
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If you want to cancel the mapping between call No. and Guard Centre, press the Delete 
Guard Centre button

 Delete Guard Centre 

Repeat the similar operation to fulfill the mapping between call No. and Guard Centre.
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Press the Write to Device button to save and download to the corresponding DT-IPC after 
finish.

The below table is the description for the mapping

Index Device Name
Direct Button Door 
Station(DMR11/D8 + 
EP24)

Digital Input Door 
Station(DMR18)

Namelist 
in Monitor

Calling 
Diversion 

28 Guard Station 4
(192.168.0.244)

Specified Button.
28th button by default 28 28 No

29 Guard Station 2
(192.168.0.253)

Specified Button.
29th button by default 29 29 No

30 Guard Station 3
(192.168.0.243)

Specified Button.
30th button by default 30 30 No

31 Guard Station 1
(192.168.0.254)

Specified Button.
31st button by default 31 31 No

32 Default GL Specified Button.
32nd button by default 32 32 Yes
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Note that: for the above example, press 32 to call Default GL, calling can be diverted when 
destination is busy or offline. The called Guard Centres and diverting order depend on 
the info that had been stored in the corresponding DT-IPC. Press View on Device of Call 
Priority to view the Guard Centre Priority. The operation for Guard Centre Priority will be 
introduced in the next part.

2)  View On Device

You can check the info in the DT-IPC by pressing the View On Device button

Continue previous operation, press the View On Device after Write to Device operation. 
The table is as follow:

Call Priority

This Call Priority operation is only for the corresponding DT-IPC.

Because we can download the default Guard Center Priority to all the DT-IPC in the Global 
Setting( eg. Click right mouse button on Benchmark Project -> Guard Center Priority), you 
should firstly press the View On Device to check if the priority setting is ok. If not, press 
View & Edit button entry the setting. 
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If you don’t want to use the Default setting, deselect the Use Project Default item, and then 
edit the private calling diverting order for the corresponding DT-IPC. Press write To Device 
button to download the info to the corresponding DT-IPC.

Click the Download All button to download Button Call Table, IP Call Table and Call Priority 
at one time.

-59-
IP-2 wire system technical guide



6.  Call Table for Digital Input Common Entrance Panel(DMR18)

192.168.0.25 had been configurated to be CDS(Common Door Station) in IP Node Config 
Chapter.

Assume that DMR18 had been connected to this DT-IPC.

For Digital Input Common Door Station(DMR18), only Common Call Table and Call Priority 
should be cared about. For Call Priority setting is similar to call Priority section in Call Table 
for Blocks chapter, this chapter just focus on Common Call Table.

Click right mouse button on Common Entrance and select Management, then select Call 
Table button into the following interface. Note that Common Call Table is equivalent to 
Input Table in the project submenu(The pop-up menu when click right mouse button on 
Benchmark project)

The default rule for digital input common door station calling monitors is ‘IP Node’ + ‘User 
Code’.

If the default calling rule can meet project requirement, only guard center calling rule is 
need to be configurated. If not, both of guard center and monitor calling rule must be 
configurated.
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Mapping Rule

*  Using Default Rule to call Guard Unit and monitors. For example, press 254-01 to call 
Guard Station 1, press 243-01 to call Guard Station 3, press 024-15 to call the monitor 
whose user code is 15 in D block. 

*  New rule for Mapping between Common Entrance and monitors

As the above CDS Input, for example, press 004-07 to call the monitor whose user code is 
15 in D block after the rules are download to device.

7.  Call Table for Direct Button Common Entrance Panel(DMR11)

For Direct Button Common Door Station, only Button Call Table and Call Priority should be 
cared about. For Call Priority setting is similar to call Priority section in Call Table for Blocks 
chapter, this chapter just focus on Button Call Table.

192.168.0.26 had been configurated to be a CDS(Common Door Station) in IP Node Config 
Chapter. Assume that DMR11/D8 and EP24 had been connected to this DT-IPC.

Click right mouse button on Common Entrance and select Management, then select Call 
Table button into the following interface.
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Press View & Edit of Button Call Table tab to edit the calling mapping, just like the following 
picture.

 

Add one user 
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It will pop up a window for you to pick a user. Just like the following picture

The picture just as following picture

 

Delete one user 
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Fulfill the call table, then press Write To Device to download the info to the corresponding 
DT-IPC. You can call user or Guard Center by the corresponding button, for example, press 
32nd button to call Default Guard Center, press 20th button to call the monitor whose user 
code is 15 in D block.

8.  Parameter Management for Blocks and Common Door Station

Because the item meanings of parameter management for blocks and common door 
station are the same. So just take B Block of Benchmark Project as an Example

Click right mouse button on B Block, select Management, then select Parameter 
Management in next page. Then it will pop up Parameter Management page
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Button Description:

Read From Device: Read all the info stored in the device

Write To Device: Write all the info to the device

Reset To Default: Reset all the info in the database to Default(Note that the operation is 
for database in PC, if you want to reset the device info, press Reset To Default and then 
press Write To Device) 

Import: Import a parameter file that has been saved before to reset the info.

Export: Export a parameter file to backup the current info.

Close: Close the Parameter Management page

General Setting Description:

Call Wait Time: To set calling waiting time for door station and monitor. Range from 10 to 
600s.  

Call Talk Time: To set limitation for talking time. Range from 10 to 600s

IM Ring Number: To set the ring times for monitor when called. Range from 1 to 4

Call Transfer Wait Time: To set waiting time before diverting calling to next Guard Center

Advanced Setting Description

a. Call Priority

To set priority for different calling. Range from 1 to 4, 1 is the lowest priority, and 4 is the 
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highest one. 

GL Call IM: To set Priority for Guard Center calling indoor monitor.

CDS Call IM: To set Priority for Common Door Station call indoor monitor.

DS Call IM: To Set Priority for door station call indoor monitor

b. 8210 Control

IP-8210 Reset Check Number: If DT-IPC had been detected offline N times, start power-
down mode. To set the N value.

IP-8210 Power Cut Time: Timing for power-down when reset DT-IPC

IP-8210 Reset Count: Counting for DT8210 resets

c. Call Table Quan

Rows of Common Call Table: To set rows of common call table. Default is 110.

Rows of IP Table: To set rows of IP Table. Default is 32.

Rows of Room Call Table: To set rows of Room Call Table. Default is 32.
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DIP Status

The DIP Status page is used to show the DIP status of SW201 in DT-IPC.

DIP OFF ON

1 Reserved Reserved
2 Other DS DT591/DT592
3 Local Guard Center Network Guard Center
4 Door Station Common Door Station 1 2 3 4

ON

Dip Status page Description

Guard Center: To show the 3rd DIP status of SW201, Local Guard Center or Network 
Guard Center. Local Guard Center stands for DIP OFF, press Direct Call Guard Unit button 
in the intercom menu of monitor to call monitor who is used as one local guard center. 
Network Guard Center stands for DIP ON, press Direct Call Guard Unit button to call Guard 
Center, PC station or Guard Station.

DS Work Mode: To show the 2nd DIP status of SW201, DT591/DT592 or other door 
station. If it shows DT591, it stands for DIP ON. In this status, when calling the monitor 
whose user code is 00/32 by Guard Center or Common Door Station, monitors whose user 
codes are in the range of 1 to 15 will respond the calling as slave monitors. If it show other, 
no such a function.

Work Mode: To show the 4th DIP status of SW201, Door Station or Common Door Station. 
If it shows Door Station, door stations works as a door station, or else, works as a common 
door station.
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§§ 3.3. IP-Agent Introduction

3.3.1 Overview

What's IP-Agent

IP-Agent is one part of PC Station. It’s a guard center that enables you communicate with 
user, entrance of blocks, common entrances and other guard centers in one residential 
area via IP network. 

Unlock door when talking with entrances or monitoring.

Capture picture of entrances when monitoring or calling entrances

Record video automatically when incoming calling from entrances

Record video manually when monitoring or calling entrances

Concepts

Device: Including PC Station, Guard Station, Common Door Station, Door Station, 
Monitors and Network Camera

IP Device.exe: IP Device.exe is used to configurated device for IP-Agent.

GL: Guard Station, eg. IP-G21, used to call entrances and users. It can monitor/unlock 
entrances too.

PC: IP-Agent, including the same function to GL, but it can record video and capture 
picture besides above-mentioned function.

DS: Door Station, A device is installed in front of block entrance to call flats or Guard 
Centers.

CDS: Common Door Station, installed in the entrances of residential area to call users and 
Guard Centers.

IM: Indoor Monitor.

IP Node: The IP address of device.

Key Features of IP-Agent 

Monitor Viewer

	 -Show all the devices that have been configurated by IP-Device.exe, Including

                lists of Guard Centers, CDS & DS, monitors and network camera

	 -Show the device name and its IP Node.

	 -It will pop up a new window for operation when calling.

	 -Unlock DS & CDS when calling and talking
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3.3.2 IP-Agent Description

	 -Capture picture of DS & CDS when monitoring, calling and talking manually.

	 -Record video of DS & CDS when monitoring calling and talking manually

	 - Record video automatically when incoming calling from DS & CDS, optional

	 -Transmit Video of related camera to monitor when calling user, optional

	 -Monitor up to 12 devices(CD/CDS) simultaneously

	 -Monitoring can be activated automatically when IP-Agent gets start.

	 -Support two kind of pixel aspect ratios formats, 4:3 and 16:9

	 -Support full screen mode.

Call List

	 -Record info of all the calls, incoming calls and missed calls

Alarm

	 -Record info of all the alarm and events

Record Viewer

	 -Replay audio and video records 

Capture Viewer

	 -Replay captured picture

Setup

	 -General Setting: Camera IP function, files path located for captured pictures and

	 video records, language selection, video type, max time for calling and monitoring.

	 -Alarm setting: Name alarm regions, set alarm sound

	 -View & Layout: Set max channel for monitoring, select DS/CDS to monitor 

	 automatically when IP-Agent get starts, view info

	 - Handset usage setting, optional

On your desktop, click the program icon that has been created automatically. IP-Agent gets 
starts.
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Login

To Access IP-Agent, you must log in with a registered account at first

1. On your desktop, double click the IP-Agent icon,the login dialog should appear.

2. Provide the user ID and password

Default ID: device

Default Password: 123456

3. Provide the Server name and Database Name

Server name: machine name + ‘\K2012’

Database Name: K2012

*  The default password can be exposed to a hacking thread so it is recommended to 
change the password by IP-Admin software after installing the product. 

Note that the security and other related issues caused by the unchanged password shall 
be responsible for the user.

*  The following is an example of login failure, if you input an incorrect ID or password, you 
will see the error message.

The following is another example of login failure, if you input an incorrect Server Name or 
Database Name, you will see the error message.
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IP-Agent at a Glance

 1 3

 

4 5 6 

2 

 

7 

Item Name Description
1 S/W Title Bar Display the name of the software
2 ID Shows the user ID
3 Monitor Launches the Monitor Viewer.
4 Record Launches the Record Viewer
5 Capture Launches the Capture Viewer
6 Setup Open the setup page
7 Exit Terminates the application

3.3.3 Monitor Viewer

From the top right corner of the IP-Agent main screen, click the [Monitor] tab.
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Name and Fuction of each Item in Monitor Viewer

Item Name Description
1 Device List Consists of 4 parts: GL&PC, DS&CDS, Monitor&Camera
2 Call List Call info record   
3 Alarm Alarm and events record
4 Unlock 1 * Unlock the first latch of the entrance
5 Unlock 2 * Unlock the second latch of the entrance
6 Capture Capture a picture of the selected video window
7 Record Performs/Stop Recording the selected video window
8 Digital Keypad Open digital keypad for operation
9 Exit Exit monitoring
10 Maximum Maximize the monitoring screen
11 Aspect Ratio Select an aspect ratio and a number of split screen
12 Reserved Reserved 
13 Reserved Reserved
14 Monitor Screen Displays the monitor viewer screen
15 Adjust Window Button Displays or hides the menu window
16 Video Screen Displays monitoring video
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Item Name Description

1 Monitor Time Displays the monitor time

2 Device Name Displays the name of the monitored device

*Note that Unlock 1 and Unlock 2 buttons can unlock the 1st and 2nd latches respectively 
if door station model can connect two latches. Both of Unlock 1 and Unlock 2 buttons can 
unlock the latch if door station model can only connect one latch

Name and Function of each Item in the  the Monitor Window

Name and Function of each Item in the Pop-up Calling Window

It will pop up a calling window for video and operation when there is a calling to DS/CDS or 
an incoming calling from DS/CDS
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Item Name Description
1 Capture Capture a picture of the video window
2 Record Performs/Stop recording the video window
3 Unlock 1 Unlock the first latch of the entrance
4 Unlock 2 Unlock the second latch of the entrance

5
Speaker Volume Adjust speaker volume via up and down button
Mic Volume Adjust mic volume via up and down button

6 Exit Exit the communication window
7 Maximum Maximize the video window
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Device List

Device List consists of 4 parts, including GL & PC, DS & CDS, Monitor and Camera.

After device configuration operation in IP Device software, all the devices that have been 
configurated in IP Device will shown in the Device List.

Icons & Description:

1. :          Device Online

2. :          Device Offline

3. :          PC Online, but IP-Agent doesn’t open

4. :          Invalid Model

5. :          Call

6. :          Monitor

a. GL & PC

GL & PC is a list of Guard Centers, including Guard Station 

and IP-Agent. In the GL & PC frame, you can see other 

Guard Center status. 

Press        button to reflash Guard Center status

Press        button to call the related Guard Center

* Call

It will pop up a calling window when calling a Guard Center. Press   button to exit the 
calling window.

Call Succeed:

1) Call and wait for picking up 2) Talking established if the called Guard 
Center picks up
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Call Failure: *

Detail refers to trouble shooting

* Incoming Call

1) Press Accept to entry talking status, 
else press Refuse to deny the calling

2) Talking established after accept the 
calling, you can press Handup button to 
end the conversation

b. DS & CDS

All the door stations & common door stations are listed in this frame.

* Search one DS/CDS

You can input full or part of a device name to search one DS or CDS in the Search input 
box.

You can call or monitor DS or CDS in the DS & CDS frame

* CALL 

Press      button to call the related DS or CDS, then it will pop up a window for video and 
operation
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* Incomcing Call

1) Press Accept to entry talking status, 
else press Refuse to deny the calling

2) Talking established after accept the 
calling, you can press Handup button to 
end the conversation

* Monitoring DS/CDS

Press    button to monitor the related DS or CDS. The video will be shown in the focused monitor 
window.
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All the monitors of one selected building are listed in this frame.

* Search a user
1) Click Building box and Select the related  building
2) Input full or part of a monitor name in the Search input box

Press     button to call the selected monitor, then it will pop up a window for calling

* Call when no IP Camera

1) Call and wait for picking up 2) Talking established if the called monitor 
picks up 

c. Monitor
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* Call when IP Camera connected

If IP Camera function is activated by setting*, video of IP Camera will be transmitted to IP-
Agent and the called monitor simultaneously. 

*Details refer to SETTING Chapter

1) Call and wait for picking up 2) Talking established if the called monitor 
picks up 

* Incoming Call

1) Press Accept to entry talking status, 
else press Refuse to deny the calling

2) Talking established after accept the 
calling, you can press Handup button to 
end the conversation
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d. Camera

You can connect one camera to IP Network via CM-IPC. 
Press   to view the network camera

Call List

Click the Call List tab to unfold the lists.
Call List is a record that includes call destination/call source, date, time and length of time

* Icons & Description of Sub Lists

1.  (All Call): All call info including outgoing calls, incoming call, missed calls

2.  (Calls): Outgoing call info 

3.  (Incomings): Incoming call info

4.  (Missed calls): Missed call info

Double click one record to call the related destination

1.All Calls 2.Outgoing calls 3.Incoming calls 4.Missed calls
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3.3.4 Record Viewer

From the top right corner of the IP-Agent main screen, click the [Record] tab.

Name and Function of each Item in Record View 

Item Name Description

1 Record List Includes audio record, video record and talking record

2 Video Screen Displays video/audio record

3 Record Controller Controls record playing

4 Progress Bar Shows the playing progress when playing record
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Name and Function of each Item in the Record Window 

Item Name Description

1 Device Name Displays the recorded device name

2 Record Time Displays the time when the video/audio was recorded

Record List

Record operation will be activated in the following cases:

1.Incoming calls from DS/CDS or monitor and respond the 
calls

2.Call DS/CDS or monitor and Auto Recording On Call function 
has been activated by setting*1

3.Monitor DS/CDS and Auto Recording On Monitor function 
has been activated by setting*2

*1 & *2: Details refer to Setting Chapter 
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Icons & Description	

1.  (All Record): All record including audio record, video record and talk record

2.  (Audio Record): Audio record for conversation between IP-Agent and monitor(based 
on setting), no video

3.  (Video Record): Video record for DS/CDS when monitoring(based on setting) , no 
audio

4.  (Talk Record): Talk record for conversation with video 

5.  (Record Filter):  Filter record by specific time and address

Double click to select one record to display in the video screen. As you see, more than one 
record can display in the video screen simultaneously, the number of displaying videos is 
up to the split number of the screen.
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3.3.5 Capture Viewer

Name and Function of each Item in the Capture Viewer

Item Name Description

1 Captured Picture List Click to select the specific picture

2 Record Filter Filter record by specific time and address

3 Video Screen Displays captured pictures

4 Slide bar Slide to adjust the number of pictures that can be viewed
simultaneously in the video screen  

5 Scroll bar Slide to browse other pictures
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To View Big Picture 

1. Select one picture in the captured picture list.

2. Double click the selected picture, then video screen will turn to big picture mode from 
browse mode. 

1) Browse mode

2) Big picture mode

If you want to back to browse mode, just double click on one picture in the video screen
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3.3.6 Setting

From the top right corner of the IP-Agent main screen, click the  button to entry setting 
page.

a. General

 Title OSD

Time: Show time in video window when monitoring or calling

Name: Show device name in video window when monitoring or calling

 IP

IP: Select the local machine address

Camera IP: Input IP Address of IP-Agent camera

Use IP Camera in IM call: Transmit video of IP-Agent camera to the called monitor 

Use IP Camera in GL call: Transmit video of IP-Agent camera to the called Guard Center                      

Capture

Capture Path: Select a path to save all captured pictures
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Record

Record Path: Select a path to save all record documents

Auto Recording On Call: Activate auto recording when IP-Agent call devices

Auto Recording On Monitoring: Activate auto recording when monitoring devices

 Language

Language: English or Chinese(Simplified) optional

 Video

Video Type: PAL or NTSC optional

Maintain the aspect ratio: Maintain the aspect ratio or not

 Timer

Max call time: To set max call waiting time		

Max monitor time: To set max monitor time for monitoring

b. Alarm Setting 

Reserved function for 2 wire system

c. View & Layout
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 Channel On Start : To set initial aspect ratio and split number of the video screen 
when IP-Agent gets start

Layout: To set initial aspect ratio for video screen when IP-Agent gets start 

Channel Number: To set initial channel number for video screen when IP-Agent gets start

Enable Max Channel: Deselect the option to disable 9 and 12 channel selection in the   
main frame 

 Monitor On Start: To select specific DS/CDS to monitor automatically when IP-Agent 
gets start

 View: Device list display setting 

Show IP: Deselect the option to hide IP address of devices

Auto Collaps List: To set display format of device list, call list & alarm list. You can unfold 
more than one list in the frame if deselecting the option. If not, you just can unfold one list, 
previous unfolded list will be folded automatically if you unfold a new list.

Auto Size List: Disable this option if deselect Auto Collaps List. If select Auto Collaps List 
& then select the option, list will be unfolded to max size.

d. Handset
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Handset: Add one handset to IP-Agent 

Use handset:  Enable a handset

Com Port: Select related com port for the connected handset

Ring Sound: Select a Ring Tone for handset

Ring Volume: Adjust Ring Volume for handset
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1.  Project Property

Project Name:		  TEST001		

Project Descriptions:	 Totally 4 blocks, 2 Common Entrances, 2 G3LV, 2 IP-Agent

Project Remark:		  2 wire system		

IP seg:			   192.168.0.X		

2.  IP Node Config

Config the IP Node which will be used in this project

IP Enable Model Device Name
192.168.0.20 yes CM-IPC Network Camera
192.168.0.21 yes DT-IPC_DS A Block
192.168.0.22 yes DT-IPC_DS B Block
192.168.0.23 yes DT-IPC_DS C Block
192.168.0.24 yes DT-IPC_DS D Block
192.168.0.25 yes DT-IPC_CDS Common Door Station 1
192.168.0.26 yes DT-IPC_CDS Common Door Station 2
192.168.0.240 yes C5-IPC Guard Unit Camera
192.168.0.243 yes PC Guard Station 3
192.168.0.244 yes PC Guard Station 4
192.168.0.253 yes GL-IPC Guard Station 2
192.168.0.254 yes GL-IPC Guard Station 1
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Default GL Input 00

The Order of Default GL call transfer

GL1 254(192.168.0.254)

GL2 253(192.168.0.253)

GL3 243(192.168.0.243)

GL4 244(192.168.0.244)

GL5 none

GL6 none

GL7 none

GL8 none

3.  Guard Centre Priority

4.  DS Config, Monitor Config and CDS Config

Why need config Door Station, monitor and common door station(CDS)	 	

1) You have to config Door station(DS), monitor and common door station(CDS) before 
setup Input Table			 

2) Config DS, monitor and CDS for using IP-Agent	 	 	

3) Can check DS, monitors and CDS if they are online			

5.  Input Table(For Global Room Input)

Why need Input Table?			 

Input table is a Global Room Input Table for DMR18(Common Door Station) to call all flats 
by using special input rules. 			 

If default input rules can meet requirement, no necessary to setup Input Table(Default: IP + 
User Code). 			 
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IP Address Model Device Name CDS 
Input

192.168.0.21 1 DT59X A Block-01(DT592)
192.168.0.21 2 DT59X A Block-02(DT592)
192.168.0.21 0001 Monitor(DT) A Block-0001(Slave) 001-01
192.168.0.21 0002 Monitor(DT) A Block-0002(Slave) 001-02
192.168.0.21 0003 Monitor(DT) A Block-0003(Slave) 001-03
192.168.0.21 0032 Monitor(DT) A Block-00 or 32(Master) 001-00
192.168.0.22 1 DMR18 B Block-01
192.168.0.22 2 DMR18 B Block-02
192.168.0.22 0001 Monitor(DT) B Block-0001 002-01
192.168.0.22 0002 Monitor(DT) B Block-0002 002-02
192.168.0.22 0003 Monitor(DT) B Block-0003 002-03
192.168.0.22 0004 Monitor(DT) B Block-0004 002-04
192.168.0.22 0005 Monitor(DT) B Block-0005 002-05
192.168.0.22 0006 Monitor(DT) B Block-0006 002-06
192.168.0.22 0007 Monitor(DT) B Block-0007 002-07
192.168.0.22 0008 Monitor(DT) B Block-0008 002-08
192.168.0.23 1 DMR11S/D(ID) C Block-01(DMR11)
192.168.0.23 2 DMR11S/D(ID) C Block-02(DMR11)
192.168.0.23 3 DMR11S/D(ID) C Block-03(DMR11)
192.168.0.23 4 DT59X C Block-04(DT598)
192.168.0.23 0001 Monitor(DT) C Block-0001 003-01
192.168.0.23 0002 Monitor(DT) C Block-0002 003-02
192.168.0.23 0003 Monitor(DT) C Block-0003 003-03
192.168.0.23 0004 Monitor(DT) C Block-0004 003-04
192.168.0.23 0005 Monitor(DT) C Block-0005 003-05
192.168.0.23 0006 Monitor(DT) C Block-0006 003-06
192.168.0.23 0007 Monitor(DT) C Block-0007 003-07
192.168.0.23 0008 Monitor(DT) C Block-0008 003-08
192.168.0.24 1 DMR11S/D(ID) D Block-01(DMR11/D8+EP24)
192.168.0.24 0009 Monitor(DT) D Block-0009 004-09
192.168.0.24 0010 Monitor(DT) D Block-0010 004-10
192.168.0.24 0011 Monitor(DT) D Block-0011 004-11
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IP Address Model Device Name CDS 
Input

192.168.0.24 0012 Monitor(DT) D Block-0012 004-12
192.168.0.24 0013 Monitor(DT) D Block-0013 004-13
192.168.0.24 0014 Monitor(DT) D Block-0014 004-14
192.168.0.24 0015 Monitor(DT) D Block-0015 004-15
192.168.0.24 0016 Monitor(DT) D Block-0016 004-16
192.168.0.24 0017 Monitor(DT) D Block-0017 004-17
192.168.0.24 0018 Monitor(DT) D Block-0018 004-18
192.168.0.24 0019 Monitor(DT) D Block-0019 004-19
192.168.0.24 0020 Monitor(DT) D Block-0020 004-20
192.168.0.24 0021 Monitor(DT) D Block-0021 004-21
192.168.0.24 0022 Monitor(DT) D Block-0022 004-22
192.168.0.24 0023 Monitor(DT) D Block-0023 004-23
192.168.0.24 0024 Monitor(DT) D Block-0024 004-24
192.168.0.25 1 DMR18 Common Door Station 1(DMR18)
192.168.0.26 1 DMR11S/D(ID) Common Door Station 2(DMR11)
192.168.0.243 PC Guard Station 3(IP-Agent) 000-03
192.168.0.244 PC Guard Station 4(IP-Agent) 000-04
192.168.0.253 GL-IPC Guard Station 2(G3LV) 000-02
192.168.0.254 GL-IPC Guard Station 1(G3LV) 000-01

When using Direct Button Door Station			 

DMR11+EP11
Specify each button to call IM or Guard Station 	         

Note: 4 can be used,but code and target relation is fixed for all 4 DS in this IPC	 	

Layout Map	 Add: Different model combination of DMR11 S/D + EP S/D	

6.  Block Setup

Network Camera(192.168.0.20)	
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A Block(192.168.0.21)				  

General Description:				  

1) 2DS and 4 IM, use DT592 model				 

2) 1st button in DT592 call all IM. 2nd button call default Guard Unit(Default GL).	

3) User Namelist in IM to call Guard Station				  

IM Description: 				  

1) Totally 4 IM in this block whose user codes are from 00 to 03				 

2) [16] in Namelist to call Default GL, [17] to call Guard Station 2(192.168.0.253), [18] to 
call Guard Station 3(192.168.0.243)				 

DS Description:				  

1) 2 DS, their ID codes : 00 and 01				  

2) 1st buttton to call all IM, 2nd button to call Default GL				  

Call Table Setup:  A Block -> right Click then select Management -> Select Call Table -> 
Select Button Call Table -> Select View & Edit				  

Edit Button Call Map table:

Index Device Name IP Adress
16 Default GL 192.168.0.254 FFFF
17 Guard Station 2(G3LV) 192.168.0.253
18 Guard Station 3(IP-Agent) 192.168.0.243

Press Write to Device to download the setup to DT-IPC(192.168.0.21) after finished

B Block(192.168.0.22)				  

General Description:  2 DS and 8 IM, use DMR18 model				  

IM Description:				  

1) User codes of 8 IM are from 01 to 08				  

2) [00] in Namelist to call Default GL, [31] to call Guard Station 2(192.168.0.253), [30] to 
call Guard Station 3(192.168.0.243)				 

DS Description:				  

1) 2 DMR18, ID code: 00 and 01				  

2) Input 32 to call Default GL, 31 to call Guard Station 2(192.168.0.253), 30 to call Guard 
Station 3(192.168.0.243)				  

Call Table Setup:  A Block -> right Click then select Management -> Select Call Table -> 
Select Button Call Table -> Select View & Edit			 
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Index Device Name IP Adress
32 Default GL 192.168.0.254 FFFF
31 Guard Station 2(G3LV) 192.168.0.253
30 Guard Station 3(IP-Agent) 192.168.0.243

Index Device Name IP Adress
09 Default GL 192.168.0.254 FFFF
10 Guard Station 2(G3LV) 192.168.0.253
11 Guard Station 3(IP-Agent) 192.168.0.243

Press Write to Device to download the setup to DT-IPC(192.168.0.22) after finished

Press Write to Device to download the setup to DT-IPC(192.168.0.23) after finished

Edit Button Call Map table:

C Block(192.168.0.23)				  

General Description: 4 DS and 8 IM, use DMR11 and DT598 model			 

IM Description:				  

1) User codes of  IM are from 01 to 08				  

2) [09] in Namelist to call Default GL, [10] to call Guard Station 2(192.168.0.253), [11] to 
call Guard Station 3(192.168.0.243)				 

DS Description:				  

1) 3 DMR11 and 1 DT598, ID code: 00,01,02,03				  

2) Press 09 to call Default GL, 10 to call Guard Station 2(192.168.0.253), 11 to call Guard 
Station 3(192.168.0.243)				  

Call Table Setup:  A Block -> right Click then select Management -> Select Call Table -> 
Select Button Call Table -> Select View & Edit				  

Edit Button Call Map table:				  

D Block(192.168.0.24)				  

General Description: 1 DMR11 + EP24 and 16 IM				  

IM Description:				  

1) User codes of IM are from 09 to 24				  

2) [00] in Namelist to call Default GL, [31] to call Guard Station 2(192.168.0.253), [30] to 
call Guard Station 3(192.168.0.243)				 
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DS Description:				  

1) 1 DMR11/8 + EP24, ID code: 00				  

2)Press 32 to call Default GL, 31 to call Guard Station 2(192.168.0.253), 30 to call Guard 
Station 3(192.168.0.243)				  

Call Table Setup:  A Block -> right Click then select Management -> Select Call Table -> 
Select Button Call Table -> Select View & Edit				  

Edit Button Call Map table:				  

Index Device Name IP Adress
32 Default GL 192.168.0.254 FFFF
31 Guard Station 2(G3LV) 192.168.0.253
30 Guard Station 3(IP-Agent) 192.168.0.243

Press Write to Device to download the setup to DT-IPC(192.168.0.24) after finished
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DT Network Benchmark Platform Diagram
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System Design Process

1.  Analyze Project Requirement

2. Count Project Points

3. Select Device Model & Make 
Device List

4. Draw System Topology Diagram

5. Make Project Technical Solution 
Document for Business

There are 3 buildings including one villa, two apartments. And there are one common 
entrance, 2 Switchboard including 1 PC station & 1 guard station in these residential 
complexes. In this application, a door entry system with the features below is required:

1) It requires a networked connection among these 3 buildings, so that the security room 
can manage the residential complexes, e.g. call each flats and receive calling from each 
flats.

2) 1 common door station before the common entrance is needed and visitor can call the 
resident for unlock.

3) A video outdoor station with ID proximity card reader shall be installed in each building. It 
must be vandal proof.

4) Construct an IP DEDICATED network to allow long distance transmission and multi-
channel communication to avoid communication block in the network like 2 Switchboards 
can call different buildings respectively at the same time.

5) One indoor monitor with image memory function shall be installed in each flat.

6) Any indoor monitor can call each other and at least 7” screen is required for good picture 
quality.

1.  Analyze Project Requirement
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All the above requirement can be met by 2-Easy intercom system.

Apartment Device

Network Device

2. Count Project Points

Building No. of floors 
for 1 building

No. of 
flats on 
each floor

Total flats IM Distributor Power 
supply Gateway DS

A Block / / 1 4 1 1 1 1
B Block 8 2 16 16 4 1 1 1
C Block 6 4 24 24 7 1 1 2
Total 41 44 12 3 3 4

Series Name Model Qty Unit Remark

1 Door Station DMR18 3 PC For B & C blocks
2 Door Station DT592 1 PC For A block
3 Monitor DT27SD 44 PC with memory function

4 Distributor DT-DBC4S 12 PC
One out of them connects 
multi-door stations in C 
Block

5 Power Supply PS5-24V 3 PC 1 power supply feeds one 
building

6 Gateway DT-IPC 3 PC

Series Name Model Qty Unit Remark

1 Guard Station IP-G21 1 PC
Total 2 Switchboards

2 PC with PC 
Station / 1 PC

3 Common Door 
Station DMR18 1 PC 1

4 Power Supply PS5-24V 2 PC One PS5 feeds one G21 and the 
other feeds common door station

5 Gateway DT-IPC 1 PC For Common Door Station

6 Network Switch / / PC The quantity of switch depends on 
project installation

3. Select Device Model & Make Device List
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System Wires

Series Name Model Qty Unit Remark

1
Wire for 
Apartment riser 
connection

Twisted Cable / Meter

Using twisted cable to 
connect riser devices in 
apartments.
2*1.0mm2 or 2*1.5 mm2 
is recommended 

2 Wire for Network 
Connection CAT5 / Meter

Connect  to  gateway, 
Switchboard and network 
switch
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DT-
DBC4S

PS5-24VDT-IPC

RF CARD

DT-
DBC4S

Gateway

1st Distributor

4th Distributor

Power Supply

Door Station
B Block

DT-
DBC4S

PS5-24VDT-IPC

RF CARD

DT-
DBC4S

Gateway

1st Distributor

6th Distributor

Power Supply

1st Door Station

C Block

DT-
DBC4S

RF CARD

2nd Door Station

1#

2#

3#

4#

13#

14#

15#

16#

1#

2#

3#

4#

21#

22#

23#

24#

DT-
DBC4S

PS5-24VDT-IPCGateway

Distributor

Power Supply

Door Station A Block

1#

2#

3#

4#

RF CARD

Common 
Door Station

DT-IPC
PS5-24V

Power Supply

PS5-24V

Power Supply Guard Station :IP-G21PC Station 

Twisted Cable 
2*1.0mm2

CAT5

Network Switch

IP backbone network

Common Entrance Security Room 

4. System Topology Diagram
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